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حق نشر

شما می توانید با رعایت نکات زیر آزادانه از مطالب این کتاب استفاده کنید:

ذکر منبع را فراموش نکنید..1

چنانچه مطلبی اضافه کردید آن را نیز آزادانه در اختیار قراردهید..2

پدید آورندگان
برای این نگارش

حجت اله مداحی

برای نگارش های قبلی

شرکت دانش بنیان سامانه های آزاد فناوری اطلاعات ایده آل آینده ایرانیان )سافا(

بازخورد
 بهدر خصوص این کتاب را به طور مستقیملطفا هرگونه پیشنهادها، انتقادها و بازخوردها و نکات خود 

  ارسال فرمایید.goodlinuxuser@chmail.irرایانامه 

تاریخ انتشار و نسخه نرم افزار
۷.1 میلادی( بMMرای نسMMخه 2۰21هجری شمسMMی و 1۴۰۰)1۴۴2این راهنما همزمان با عید غدیر 

آغاز شد.

ممکن است در سایر نسخه مقداری تفاوت وجود داشته باشد.

تقدیم به سیدالشهداء، حضرت اباعبدالله الحسین و  ارواح طیبه همه شهدا که آزادگان جهانند.
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راهنمای شروع به کار با لیبره آفیس-رایتر

مقدمه



این کتاب برای چه افرادی است؟

لیبره آفیس یک مجموعه نرم افزار اداری پرکاربرد، آزاد، متن بMMاز اسMMت کMMه شMMامل چنMMدین برنامMMه
هMMای داده و فرمMMول نویسMMیپایگاه قدرتمند برای واژه پردازی، صفحات گسترده، ارائه ها، گرافیک ها ، 

است.

رایMMتر یMMک نMMرم افMMزار واژه پMMرداز اسMMت کMMه بMMا قMMالب هMMای متنMMوع از جملMMه مایکروسMMافت ورد)
doc,  .docx هMMالب ازجملMMدین قMMود را در چنMMسازگار است و شما می توانید کار خ ) .pdfروجیMMخ 

بگیرید.

 خواهMMدیافت.ارزشمندهر فردی که می خواهد به سرعت بالا در  در کار با  رایتر برسد این کتاب را  
شما ممکن است در استفاده از نرم افزار واژه پرداز تازه کار باشید یا ممکن اسMMت بMMا دیگMMر مجموعMMه

نرم افزارهای اداری آشنا باشید.

چه چیزی در این کتاب است؟

 را۷.1این کتاب ویژگی ها و امکانات اصلی رایMMتر یعMMنی بخش واژه پMMرداز از مجموعMMه لیMMبره آفیس 
معرفی می کند و دستورالعمل استفاده از آن را فراهم می سازد.

یادداشت

نسخه های برخط و دیگMMر نسMMخه هMMا نوشته شده است؛ ۷.1این کتاب برای نسخه 
ممکن است از آنچه در این کتاب توضیح داده شده است  در ظMMاهر و عملکMMرد کمی

متفاوت باشد.

۷ | چه چیزی در این کتاب است؟



لیبره آفیس را از کجا بگیرم؟

برای لینMMوکس، وینMMدوز و مکینتMMاش بMMه طMMور رایگMMان و آزاد در لیبره آفیس نسخه های مختلفی از  
در دسترس است. کاربران https://www.libreoffice.org/downloadدسترس است و از نشانی  

لینوکس همچنین نسخه متناسب با توزیع های مخلف لینوکس را خواهندیافت. در صMMفحه بMMارگیری
نسخه قابل حمل)بدون نیاز به نصب( و نسخه های دیگر فهرست شده است. 
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راهنمای شروع به کار با لیبره آفیس-رایتر

۱فصل 
آشنایی با محیط برنامه



معرفی-رایتر چیست؟

 واژه پرداز مجموعه آزاد و پر امکانات لیبره آفیس آزاد است. به عبMMارتی بMMرای  امکانMMاتبخشرایتر 
معمول یک واژه پرداز)درج متن، ویرایش و قالب بندی،صفحه آرایی، بررسMMی کننMMده دسMMتور زبMMان،

فرهنگ جامع و تصحیح خودکار؛ جستجو و جایگزینی؛ و…( رایتر امکانات فوق العاده ای دارد.

(word processor)واژه پرداز 

رم افزاری است که از آن برای ایجاد، ویرایش، صفحه آرایی و تولید صMMفحات متMMنین
استفاده می شود که البته ممکن است شامل تصاویر و اشکال گرافیکی نیز باشد.

صفحه آرایی

به آرایش متن، نحوه چیدن تصاویر، حاشیه بندی صفحات و تنظیمات چاپ، صفحه
آرایی گفته می شود.

اجزای پنجره اصلی رایتر

 نشان داده شده است که در این بخش در مورد آن توضیح داده1 شکل شماره پنجره اصلی رایتر در 
شده است.

یادداشت

به طور پیش فرض، دستورات رایتر لیبره آفیس همان طور که در این بخش توضMMیح
رایتر بMMرای دسترسMMی بMMهداده شده است در منوها و نوارابزارها گروه بندی شده اند. 

ابزارها و دستورات، هفت رابط کMMاربری  متنMMوع از جملMMه روبMMان کMMه مشMMابه آن در
viewمایکروسافت ورد وجود دارد را از طریMMق منMMوی  ...  →  User  Interface

فراهم آورده است.
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 نوار عنوان
Titleنام لاتین آن   Barاری در آنMMده جMMام پرونMMه نMMاست و در بالاترین قسمت پنجره قراردارد ک 

 را ذخMMیره نکMMردهآن تMMاکنونمشاهده می شود.در صورتی که پرونده جاری نامی نداشته باشد یعMMنی 
)بی عنوان( را مشاهده خواهید کرد.untitledباشید 

نوار منو
Menuنام لاتین آن   BarتمMMت و در سیسMMاست و جای آن در لینوکس و ویندوز زیر نوارعنوان اس  

عامل مک بالای صفحه نمایش است. موقعی که شما یکی از منوها را انتخاب می کنید یک زیرمنو باز
می شود که گزینه های بعدی را نمایش می دهد از جمله:

( درSave( یMMا ذخMMیره)Closeفرامینی  که بلافاصله عملی را انجام می دهند مانند بستن)•
(Fileمنوی پرونده)

فرامینی که پنجره های محاوره ای را باز می کنند که بMMا سMMه نقطMMه در ادامMMه فرمMMان قابMMل•
تشخیص هستند، مانند

... Find and Replace(در منوی ویرایش Edit)

فرامینی که زیرمنوهای بعدی را باز می کند. آن ها با پیکان کوچکی  مشخص هستند که در•
(. بMMاView در منMMوی نمMMا)Zoom( و Toolbarsادامه فرمان آمده است، مانند نوارابزارها)

 مکان نما روی آن ها، زیرمنو باز می شود.بردن 
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جانبینوار 
 نشان داده شده است  به طور معمول  ] بMMه1 است و همان طور شکل شماره Sidebar نام لاتین آن

طور پیش فرض در زبان های راست به چپ مانند فارسی، سمت چپ و در لاتین سمت راسMMت[  در
کنار پنجره رایتر باز است.

  در نوار ابزار می توانید آن را ظاهر یا مخفی کنید.همچنینSidebar←در صورت لزوم از منوی نما  
 دیده می شMMود، دکمMMه ای در کنMMار خMMود  بMMرای نمMMایش2نوار کناری همان طور که در شکل شماره

دادن/مخفی کردن دارد.
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(، صMMفحه)Properties دسته است: خصوصMMیات)۶نوارکناری رایتر به طور پیش فرض مشتمل برا 
Page(بک هاMMس ،)Styles(هMMنگارخان ،)GalleryاوMMبر)(، نNavigator(بکMMازرس سMMو ب ،)Style

Inspector  نوار  باز می شود. کناری( است.هر دسته با کلیک رو شمایل مربوطه 

یک تابلو ترکیبی از نMMوارابزار و پنجMMره  محMMاوره ایهر دسته شامل نوار عنوان و محتویات تابلوهاست.
است. نوارابزارها و تابلوهای نوارکناری کاربردهای زیادی به اشتراک می گذارنMMد. بMMه عنMMوان مثMMال،

( می کند  هم در نوار ابزار قالب بندی در پنجMMره اصMMلیitalic(یا مایل)Boldشمایلی که متن را توپر)
( در دسته خصوصیات.Character panelوجود دارد و هم در تابلو نویسه)

رای هماهنگ کردن عMMرض نوارکنMMاری، نشMMانگر موشMMی را دیMMواره بین فضMMای کMMاری و نوارکنMMاریب
قراردهیدو هرگاه شکل نشانگر به پیکان دو طرفه تغییر کرد، کلیک کنید و به راست یا چپ بکشMMید.
اما این کار کارایی چندانی ندارد چراکه برخی از دسته های با توجه بMMه محتویMMات آن از حMMد معیMMنی

کم عرض تر نمی شوند.
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یMا بMه شناور کنیMد از گوشه پنجره اصلی جدا کنید و به عبارت دیگر آن رابرای این که نوار کناری را 
گوشه دیگر پنجره وصل کنید از فهرست کشویی تنظیمات نوار کناری واقع در بMMالای نMMوار اسMMتفاده

 را ببینید(۳کنید.) شکل شماره

ز همیناباشMMد هم می توانیMMد فعMMال برای انتخاب این که می خواهید چه زبانه هMMایی در نوارکنMMاری 
فهرست  استفاده کنید.

جانبیدسته های نوار 
 در نوار کناری در زیر شرح داده شده است.شامل شدهدسته های 

 حاوی ابزارهایی برای قالب بندی مستقیم محتواست.(:Propertiesدسته خصوصیات)

زمانی که یک متن انتخاب شده باشد این تابلوها ظاهر می شوند::

(: اعمال، ایجاد یا به روزرسانی سبک یک بند.Stylesسبک ها)–

(:اصلاح خصوصیات متن مانند نام قلم، اندازه، رنگ، وزن یا فاصله بین نویسه ها.Characterنویسه)–

(: اصلاح ترازبندی بند، رنگ پس زمینه، تورفتگی، فاصله و شماره یا علامتگذاریParagraphبند)–
فهرست ها.

 یا گرافیک انتخاب شده باشد این تابلوها ظاهر می شوند:تصویرزمانی که یک 

اصلاح نحوه پر بودن رنگ و شفافیت پس زمینه تصویر(: Areaناحیه)–
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حالت رنگ، و شفافیت.( رنگ، contrast : اصلاح روشنایی، تضاد)(Imageصویر)ت–

 به متن دور آن.با توجه (: اصلاح موقعیت شکل یا تصویرWrap لفافه)–

دوران یا برگرداندن(:اصلاح پهنا، ارتفاع، Position and Sizeموقعیت و اندازه)–

زمانی که شی رسم شده انتخاب شده باشد این تابلوها ظاهر می شوند:

اصلاح نحوه پر بودن رنگ و شفافیت پس زمینه تصویر(: Areaناحیه)–

 هماهنگی درخشش یا لبه های نرم و شفافیت  پس زمینهیا(:افزودن Effectجلوه)–

خط: اصلاح پیکان ها، سبک خط، پهنا، رنگ و شفافیت پس زمینه–

دوران یا برگرداندن(:اصلاح پهنا، ارتفاع، Position and Sizeموقعیت و اندازه)–

زمانی یک چارچوب انتخاب شده باشد این تابلوها ظاهر می شوند:

اصلاح نحوه پر بودن رنگ و شفافیت پس زمینه تصویر(: Areaناحیه)–

دوران یا برگرداندن(:اصلاح پهنا، ارتفاع، Position and Sizeموقعیت و اندازه)–

 که  چهار تابلو دارد:صفحه استحاوی ابزارهایی برای قالب بندی مستقیم (:Pageدسته صفحه)

(:اصلاح اندازه،پهنا، ارتفاع،جهت و حاشیه های صفحه.Formatقالب)–

سبک ها: اصلاح سبک شماره گذاری صفحه، پس زمینه، چیدمان و تعداد ستون ها.–

(:فعال/غیرفعال کردن سرصفحه و اصلاح حاشیه ها، فاصله ها و محتویاتHeaderسرصفحه)–

 اصلاح حاشیه ها، فاصله ها و محتویاتپاورقی و (:فعال/غیرفعال کردن Footerپاورقی)–

احتیاط

 تغییراتی که در گزینه های دسته صفحه، شما سMMبک صMMفحه در حMMالبا آگاه باشید 
استفاده را تغییر خواهید داد، اصلاح نه فقط برای صMMفحه جMMاری بلکMMه بMMرای همMMه

صفحاتی است که در این سند از این سبک استفاده می کنند.

مدیریت سبک های استفاده شده در(: Styles and Formattingدسته سبک ها و قالب بندی)
سند، اعمال سبک های موجود، ایجاد سبک های جدید یا اصلاح آن ها.
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 نگارخانMMه. نگارخانMMه دو بخشتم هMMاینمایش تصاویر و نمودارها در (:.. Galleryدسته نگارخانه)
تم ها بر اساس نام )پیکان ها، گلوله ها، نمودارها و غیره( و دومی نمMMایشدارد: اولی فهرست هایی از 

تصاویر مربوط به تم انتخابی.

کاوش سند و تشخیص محتوای آن بر اسMMای انتخMMاب دسMMته بنMMدی(:Navigatorدسته ناوبری)
برای اطلاعات بیشتر کار بMMا نMMاوبری درمحتوا از قبیل سرفصل ها، جدول ها، قاب ها، تصاویر و غیره. 

صفحات بعد را مطالعه بفرمایید.

نمایش همه ویژگی ها سبک های بند، سبک های نویسه،(:Style Inspectorدسته بازرس سبک)
و قالب بندی دستی متن انتخاب شده.

نوارابزارها
لیبره آفیس دو نوع جایگاه نوارابزار دارد: ثابت و شناور.در حالت ثابت نوارابزارها می تواند به جاهای
مختلفی جابجا شود)مثلا بالا، پایین یا کنار فضای کاری( و حتی شبیه یک پنجره مسMMتقل،  شMMناور در

هر جای صفحه که خواستید قرارگیرند یا دوباره در قسمتی از صفحه، ثابت شوند.

آشکار یا پنهان کردن نوارابزارها
 برویMMد و روی نMMام هMMر← نم..ا نواره..ای اب..زاربرای آشکار یا پنهان کردن نوارابزارها، از نوار منو به

نوارابزاری که مدنظر دارید کلیک کنید تا با علامت دار شدن یMMا برداشMMتن علامت آن نMMوارابزار بMMه
هدف خود برسید.

برای مخفی کردن یا به اصطلاح بستن نوارابزار راه دیگری هم وجود دارد و آن کلیک راسMMت کMMردن
 که آخرینه گزینه از منویی است که باز  می بستن نوارابزارروی فضای بین دو آیکن و انتخاب گزینه

شود.

نوار ابزارهای پرکاربرد
(1در  لیبره آفیس به طور پیش فرض اولین نوارابزاری که زیر نوارمنو دیده می شMMود)شMMکل شMMماره 

نوارابزار استاندارد خوانده می شود.
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( است که اگر شکل یاFormatting toolbarدومین نوارابزار پرکاربرد در بالا نوار ابزار قالب بندی) 
تصویر انتخاب شود مخفی می شود و نوارابزار ویژگی های مربوط به تصMMویر یMMا شMMکل نمMMایش داده

می شود.

برای داشتن فضای بیشتر می توانید همان طور که قبل تر گفته شد این دو نMMوارابزار را ببندیMMد و بMMه
← نما  نوار ابزارها  جای آن از منوی ←standard(single mode) را انتخاب کنید که شامل

ابزارهای پرکاربردتر این دو نوار ابزار است.

زیرمنوها و جعبه ابزارها
شمایل های روی نوار ابزار که مثلث کوچکی کنارشان است زیرمنو یا جعبه ابزار  بیشتری مربMMوط بMMه

آن ابزار دارد.

یک جعبه ابزار  مجموعه ای از ابزارهای ضمیمه به یک ابزار است مثلا وقتی روی مثلث کوچک ابزار
شکل بزنید جعبه ابزار شامل انواع اشکال مشاهده خواهدشد. یک جعبه ابزار را همMMان طMMور کMMه در

 می بینید می توان  به عنوان یک نوار ابزار شناور باز نگه داشت. جعبه ابMMزار جMMدا شMMده نMMیز۴شکل 
دارای نوار عنوان است و  می توانید شبیه دیگر نوارابزارها آن راجابه جا یا  ثابت کنید.
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جابه جایی نوارابزارها
می توانMMد بMMه متصل در همان حMMالت هرچند می تواند از حالت ثابت خارج شود، ثابتنوارابزارهای 

 جابجا شود. چپ یا راست

برای جداکردن نوار ابزار:

 نشان داده شده5نشانگر موشی را روی دستگیره های نوارابزار ببرید)نوار عمودی کوچک ابتدای نوار ابزار که در شکل (1
است(

دکمه کلیک را پایین نگه دارید و نوار ابزار را به محل جدید بکشید.(2

دکمه موشی را رها کنید.(3

برای انتقال نوارابزار شناور-شبیه سایر پنجره ها-روی نوار عنوان کلیک کنید و به محل دیگر بکشید
یا اگر خواستید آن را به بالا یا پایین پنجره اصلی متصل کنید.

یادداشت

شما همچنین می توانید برای ثابت یا به عبMMارتی متصMMل کMMردن نMMوارابزار، روی نMMوار
عنوان آن دوبار کلیک کنید.

نکته

اگر دستگیره های نوارابزار دیده نمی شود موقعیت آن قفل شده است.برای بازکردن،
Lockقفل کردن موقعیت نوارابزار)روی آن کلیک راست کنید و سپس گزینه 

Toolbar Position).را از حالت انتخاب خارج کنید 
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خط کش ها
خط کش افقی در عرض بالای فضای کاری به طور پیش فرض مشاهده می شود اما خط کش عمMMودی

نما < خط کش ه..ا)به طور پیش فرض مخفی است. برای فعال کردن خط کش عمودی، از نوار منو، 
Rulersاب کنید ( < خط کش عم..ودیMMا از را انتخMMابزار ه..ا < گزینه ه..ا… <  ی LibreOffice

Writer > خط کش عمودی)نما ،Virtual rulerیا مخفی ( را علامت بزنید.برای به سرعت ظاهر 
 استفاده کنید.Ctrl+Shift+Rکردن هر دو خط کش از کلید ترکیبی 

نکته

دارد؛ اگMMر بMMرایود ( در انتهای خcommentsخط کش افقی یک دکمه توضیحات)
برخی بخش های سند توضیح درج شده باشد با کلیMMک روی این دکمMMه بMMه سMMرعت

قسمت توضیحات مخفی یا آشکار می شود.

نوار وضعیت
نوار وضعیت رایتر در پایان فضای کاری قرار دارد و اطلاعاتی درباره سند و راه های راحتی برای تغییر
سریع برخی ویژگی های سند فراهم می کند. این نوار می تواند از منوی نما با خارج کردن از انتخاب،

مخفی شود.

کلیدهای میانبر محیط کار
 کلید های میانبریدر لیبره آفیس هم شبیه سایر برنامه هابرای دسترسی ساده تر و سریع تر به فرامین

تا بدون نیاز به حرکت موشی بتوانید سریع تر فMMرامین مMMدنظر خMMود راهم در نظر گرفته شده است. 
(Save در لیبره آفیس و بیشتر برنامه های کMاربردی کلیMد میMانبر ذخMMیره)Ctrl+sاجرا کنید. مثلا 

است.

کلید میانبر فرامینی که در منوها مشاهده می شود رو به روی نوشته شده است.
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یادداشت

در رابط کاربری فارسی کلیدهای کنترلی صفحه کلید هم ترجمه شMMده انMMد! مثلا بMMه
Shift در نام کلیدمیانبر کلمه مهار را مشMMاهده خواهیMMد کMMرد.)بMMه جMMای Ctrlجای 

 دگرساز.Altتبدیل  و به جای 

نکته

و حرف زیرخط دار منو یا زیر منوی مربوطه می توانید بMMه آن  Alt با فشردن کلید 
  را برایFile  هم منوی F  و Altمنو دسترسی داشته باشید. مثلا فشردن  کلیدهای 

شما باز می کند و فشردن حرف زیر خط دار زیرمنوها مشMMابه کلیMMک روی آن عمMMل
خواهدکرد.

Altدر صفحه کلید استاندارد فارسی 

(Altبرای نکته قبل در هنگام فارسی بودن صفحه کلید ممکن اسMMت فقMMط دگرسMMاز)
سمت چپ کار کند چراکه در صفحه کلید استاندارد فارسی کلیدها سه حالت دارند،

( فشرده شوند که معمولا برای اعراب وShift حالتی که با تبدیل)2: حالت عادی، 1
(سMMمت راسMMتAlt حالتی کMMه بMMا دگرسMMاز)۳علایم)ویرگول و …( استفاده می شود، 

فشرده شوندکه در این حالت می توان علائم لاتین را بدون لاتین کردن صفحه کلید
ظاهر کرد یعنی بدون این که برای نوشتن@ بدون این که صفحه کلید را لاتین کنید

 را بنویسید و دوباره صفحه کلید را فارسMMی کنیMMدعلامت این 2  و عددShiftو بعد با 
 به سادگی این کار را انجام دهید.2 سمت راست و عدد Altمی توانید با 

ایجاد سند جدید خالی

شما از چندین طریق می توانید یک سند جدید یا خالی در رایتر ایجاد کنید. 
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از مرکز شروع
 (دیده می شود.۶هنگامی که لیبره آفیس باز است اما سندی باز نیست، مرکز شروع)شکل شماره

البته همان طورCreate: Writer Document روی   کلیک کنید تا یک سند متنی ایجاد شود؛ 
قالبیتا  هم  می توانید کلیک کنید Templates بیشتر توضیح داده خواهدشد روی  کمی بعد، که 

غیر از قالب پیش فرض برنامه برای سند جدیدتان انتخاب کنید.

نوار منو، نوارابزار یا صفحه کلیداز 
اگر رایتر باز باشد شما از سه راه دیگر می توانید سند جدید ایجاد کنید:

Ctrl+Nفشردن کلید ترکیبی •

 (از نوار منوFile > New > Text Document ) متنینوشتارپرونده < جدید < انتخاب •

 روی نوارابزار استاندارد(New icon جدید )کلیک روی شمایل •
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(Template موجود)الب هایایجاد سند جدید بر اساس ق

(است. قMMالب،Templateیکی از قابلیت های رایتر برای تسریع در کارهای تکراری استفاده از قالب)
 متن، قالب بندی، سبک، تصاویر پس زمینMMه ومجموعه ای از پرونده ای ویژه ای  است که  می تواند 

 قابل استفاده است)شبیهمشابه باشد و مثل یک فرم خام برای کارهای مشابه  یا تکراری سایر موارد 
قابل استفادهنامه های اداری با سربرگ مشخص(.  سبک ها و تنظیماتی است که در ایجاد سند جدید 

.مزیت استفاده از قالب برای ایجاد سMMند جدیMMد این اسMMت کMMه تنظیمMMات و طMMراحی ظMMاهریاست
سندجدید مشابه قالب انتخاب شده است و نیاز به طراحی و تنظیمات مجدد نیست.

برای بازکردن پنجره قالب ها، به این یکی از این روش ها اقدام کنید:

Ctrl+Shift+Nاستفاده از کلید میانبر  •

< File > Templates < مدیریت قالب ها از نوار منو)Templatesانتخاب پرونده < •

Manage Templates)

(File > New > Templatesانتخاب پرونده < جدید < قالب ها از نوار منو)•

( روی نMMوارابزار اسMMتاندارد وNew iconکلیMMک روی مثلث کوچMMک شMMمایل جدیMMد)•
Templatesانتخاب  ...

 قالب های مربوط به نوشتار)سندهای های متMMنی( مشMMخص۷نمونه نشان داده شده در شکل شماره
است. کافیست روی قالب دلخواهتان دوبار کلیک کنید تا سندی با آن قالب ایجاد شMMود. همچMMنین

 کلیک کنید.(Openبازکردن)می توانید یک قالب انتخاب کنید و روی دکمه 
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مدیریت اسناد

پس از اسند جدید و تکمیل آن، لازم است یجاد یک اسنادی که در سند را ذخیره کنیم یMMا ببنMMدیم.
همچنین ممکن است در آینده بخواهیم مجددا نوشتار را در رایتر باز کنیم.

ذخیره کردن سند
Save ذخ..یره ب..ا عن..وان...) یا فرمان(Save ذخیره)شما می توانید یک نوشتار را با فرامین  as)

ذخیره کنید.
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فرامین ذخیره سازی

ذخیره پرونده جدید یا پرونده از قبل ذخیره شده
یکی از کارهای زیر را انجام دهید:

.Ctrl+Sفشردن •

(File > Save از نوار منو) پرونده < ذخیرهانتخاب•

 ( روی نوارابزار استاندارد.Save icon)ذخیرهکلیک روی شمایل •

نکرده باشید، با انجام هر یک از گزینه های فوق، پنجره ذخیره به عنوان) نوشتار جدیدتان ذخیره  اگر
Save  asازی آن راMMیره سMM( باز می شود. نامی برای پرونده وارد کنیدو از نوع)پسوند( و محل ذخ

 کلیک کنید.ذخیرهبازبینی کنید و روی 

پس از این که سند را ذخیره کردیم، ممکن است مجددا تغییراتی را در آن اعمال کنیم. بهMMتر اسMMت
چر چند دقیقه  یکبارسند را ذخیره کنیم تا در صورت ایجاد مشکلی مانند قطع شدن برق، تغیMMیرات

داده شده از بین نرود.

برای ذخیره پرونده جاری نیز به همان ترتیب گفته شده عمل می کنیم:

.Ctrl+Sفشردن •

(File > Save از نوار منو) پرونده < ذخیرهانتخاب•

 ( روی نوارابزار استاندارد.Save icon)ذخیره کلیک روی شمایل •

بدیهی است اگر نوشتار را از قبل ذخیره کرده باشید پس از انجام هر یک از گزینه های بالا، برای نMMام
 نیست و پرونده با همان نام و نوع در همMان محMل فعلیاضافه تریو نوع و محل پرونده نیاز به کار 

ذخیره خواهدشد.

پرونده جاری

سندی  که هم اکنون در داخل آن قرار داریم و نام آن در نوار عنMMوان)بMMالای پنجMMره(
مشخص است را پرونده جاری می گوییم
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(Save a copyذخیره یک رونوشت)
وقتی استفاده کنید که می خواهید سند فعلی باز بماند و و رونوشMMت جداگانMMه ای هم ازاز این دستور 

نگارش فعلی ذخیره کنید.

Save As را که انتخاب کردید، پنجره محاوره ای Save a Copyوقتی از نوار منو،  پرونده <  ...

ظاهرشد، نام، نوع و محل را وارد یا تایید کنید و سپس روی ذخیره کلیک کنیMMد. رونوشMMت ذخMMیره
شده باز نمی شود و پرونده اصلی باز و فعال باقی  می ماند.

ذخیره همه
این فرمان همه پرونده های باز را ذخیره می کند.

را انتخاب کنید تا بدون تغییر در نام، نوع یا( File > Save All پرونده < ذخیره همه)از نوار منو،
محل ذخیره سازی همه پرونده های باز  ذخیره شوند.

(Save asذخیره به عنوان )
 جدید با نام یا نوع یا محل ذخیرهسندی فعلی را به عنوان نگارش گاهی اوقات ممکن است بخواهیم

سازی دیگری ذخیره کنیم. برای این کار به صورت زیر عمل می کنیم:

File پرونده < ذخیره به عنوان)از نوار منو،   >  Save  As )انبرMد میMدیا کلیMاب کنیMرا انتخ
Ctrl+Shift+S را بزنید تا پنجره ذخیره باز شود، سپس نام یا نوع یا محل جدید را مشخص کنید و

در نهایت روی ذخیره کلیک کنید.

(Save as ) و ذخیره به عنوان(Save a copy)فرق ذخیره رونوشت

وقتی ذخیره به عنوان را انتخاب می کنید نگارش فعلی جداگانه ذخیره خواهد شد با
این تفاوت که پرونده اصلی با آخرین ذخیره سازی قبلی بسته می شود و سندی که باز
است در واقع سند جدید ذخیره شده است.اما در ذخیره یک رونوشت همان طور که
گفته شد تغییرات تا آن لحظه در پرونده ای دیگر ذخیره می شود بMMدون این کMMه بMMاز

شود و شما می توانید ادامه تغییرات را شما در پرونده اصلی انجام  دهید.
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یادداشت

PDFلیبره آفیس از عبارت »صدور« برای خروجی گرفتن در قالب های دیگر ماننMMد 

 استفاده می کند.ePubو 

بازکردن سند
 از چندین راه می توانیم اسناد موجود را باز کنیم، از جمله:

 از مرکز شروعRemote files ا  یOpen File  کلیک روی •

 از نوار منو.File > Open Remote یا ( File > Open.)   پرونده < بازکردن..انتخاب•

.Ctrl+Oفشردن  •

روی نوار ابزار استاندارد.( Open iconکلیک روی شمایل بازکردن)

 را مشMMخص می کMMنیم ودر صورت نیاز محل و نوع پرونMMدهد، ابتدا شهنگامی که پنجره بازکردن باز
 کلیک می کنیم. بازکردنسپس پرونده مورد را انتخاب و در نهایت روی دکمه 

برای باز کردن سندیی که اخیرا در رایتر باز شده باشد روش های ساده تری هم هست:

کلیک روی تصویر بند انگشتی سند نظر را در صفحه شروع•

 < از نوار منو و انتخاب سند مورد نظرپرونده < بازکردن نوشتار های اخیرانتخاب •

( روی نوار ابزار استاندارد.Open iconکلیک روی مثل کوچک روبه پایین کنارشمایل بازکردن)•

(Switch Windowsتعویض پنجره فعال یا پرونده جاری)
همان طور که می دانید فقط یک پرونده جاری می توانیم داشته باشMMیم یعMMنی همزمMMان نمی تMMوانیم

 توانیم از منMMویمی چندین سند باز نیازمند ویرایش باشد  مشغول نوشتن در چندسند باشیم.اما اگر
در نوارمنو، فهرست پنجره های باز را ببنیم و سند مورد نظر خود را انتخMMاب کMMنیم تMMا پنجMMرهپنجره 

فعال ما شود.

بستن سند
برای بستن پرونده جاری یکی از روش های زیر را به کار می بریم:
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 را انتخاب می کنیم.بستناز نوار منو، •

  را می فشاریم.Ctrl+wیا کلید میانبر •

  را می فشاریم.Alt+F4یا کلید میانبر •

  روی نوار عنوان کلیک می کنیم.Xیا روی  دکمه کنترلی  •

 را انتخاب می کنیم.بستننوار عنوان کلیک راست می کنیم و از منوی ظاهرشده یا بر روی •

 کMMه میگر تغییرات داده شده را ذخیره نشده باشد، در هنگام بستن پرونده، اخطاری داده می شMMودا
کلیک کنید.ذخیره یا عدم ذخیره یا انصراف از بسته شدن پرونده توانید روی دکمه 
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راهنمای شروع به کار با لیبره آفیس-رایتر

۲فصل 
ویرایش سند



 روش های نمایش سند

رایتر سه شیوه کلی برای نمایش و ویرایش یک سند دارد: عادی، وب و تمام صفحه. برای تغییر نما،
از منوی نما روی نمایی که نیاز داریم کلیک می کنیم.

نما یا در واقع پیش نمایش چاپ هم نمای دیگری است که البته غیرقابل ویرایش است که می تMMوانیم
( فعال کنیم.File > Print Preview)آن را از پرونده < پیش نمایش چاپ

(Normal viewنمای عادی)
نمای عادی، نمای پیش فرض رایتر است که سند را همان طور که قرار است چاپ یا پی دی اف شود

نشان می دهد.

می توانیم سرصفحه و پاورقی و سایر فضMMاهای خMMالی بین صMMفحات رادر نمای عادی در صورت نیاز 
از نوار منو برداشته  Show Whitespace نما <  مخفی کنیم؛ برای این کار علامت انتخاب از

شود.

نکته

Single-pageنمای تک صفحه ای)  ViewدازهMMه انMMه بMMا توجMMچند صفحه ای ب ،)
Multiple-pageصفحه نمایش و بزرگنمMMایی فضMMای کMMاری )  View(ابیMMو کت )

Book Viewه رویMMمایل مربوطMMهم نماهای عادی هستند که با کلیک روی ش )
نوار وضعیت در کنار ابزار بزرگنمایی قابل استفاده هستند.

نمای وب
 آن را در مرورگر اینترنتی در حال مشاهده هستیم. گویانمای وب سند را آن طور نشان می دهد که 
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نمای تمام صفحه
در این نما، نوار ابزارها و نوارجانبی وجود ندارد؛ سند تمام ناحیMMه را پMMر می کنMMدو البتMMه  بMMر اسMMاس

تمMMام صMMفحه ازبزرگنمایی  و چیدمانی که در نمای عادی انتخاب شده بMMود. بMMرای رفتن بMMه نمMMای 
  کلیMMدیا برای خروج از این نما هم می توانیم می کنیم و  استفاده  Ctrl+Shift+Jکلیدهای  میانبر 

Esc.را بفشاریم یا کلیدها را یک بار دیگر بفشاریم  

انتخاب کردن متن

برای انجام کارهای ویرایشی بر روی متن، لازم است ابتدا متن مورد نظر را با موشی یا صMMفحه کلیMMد
انتخاب کنیم.

انتخاب متن

(قسمتی از متن برای ویرایش، قالب بندیHighlight کردن)رجسته یا درخشانبه ب
یا رونوشت گرفتن و … از آن، انتخاب کردن متن می گوییم.

(paragraphبند)

  از هم جدانشده اند، بند می گوییم.Enterبه عبارات یا جملات پشت سر هم که با 
به عبارت ساده با نقطه سرخط یک بند به پایان می رسد.

 انتخاب متن در رایتر شبیه انتخاب متن در دیگر برنامه های کMMاربردی اسMMت. می تMMوانیم نشMMانگر
 مورد نظر ببریم و چندبار کلیک کنیم برای انتخاب یک کلمه)دوبار کلیک(، یMMکمتنموشی را روی 

جمله)سه بار کلیک( و یک بند)چهاربار کلیک(.

 و هم استفاده کنید.ctrl و shiftباز هم شبیه انتخاب در برنامه های دیگر می توانیم از کلیدهای 

جMMایی  را نگهداشته ایم به کمک کلیدهای جهتی)بالا-پایین-چپ-راست( یا اگMMر shift وقتی دکمه 
همچMMنین مMMادیگری از متن کلیک کنیم فاصله بین کلیک جدید و محMMل قبلی انتخMMاب خواهدشMMد.

افزایش استفاده کنیم تا با کلیک محدوده انتخاب را shift به جای نگه داشتن f8می توانیم از کلیک 
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Extended  حالت انتخاب در واقع به حالت انتخMاب افزایشMی)f8دهیم. با   selectionدیلMتب)
 دوباره، حالت انتخاب را به حالت استاندارد انتخاب بر می گرداند.f8می شود و 

 را۸یک راه برای تغییر حالت های انتخاب استفاده از شمایل مربوطه در نوار وضعیت اسMMت.)شMMکل 
ببینید(. موقعی کMه روی آن کلیMک راسMت کMنیم منMویی بMاز می شMود کMه گزینه هMای مختلفی در

  عمMMلshift کMMه مشMMابه  f8دسترسمان قرار می دهد.انتخاب استاندارد، انتخMMاب افزایشMMی)کلیMMد 
( و انتخMاب بلMوکی) عم@@ل می کندctrl مش@ابه نگ@@ه داش@@تن Shift+F8می کرد، انتخMاب اضMافه)

Ctrl+Shift+F8که  به ما امکان انتخاب متن  چند نویسه یا کلمه از ابتدا، میانه ی@@ا انته@@ای چن@@د 
خط می دهد(

غیر پیوسته قسمت هاانتخاب 
 پس از انتخاب اولین قطعه متن به کمک موشی،۹برای انتخاب قسمت های غیرپیوسته شبیه شکل 

Ctrl را پایین نگه می داریم و  قطعه متنی دیگر را انتخاب می کنیم. به جای نگMMه داشMMتن ctrlدکمه 

م تا چند متن را بتوانیم همزمان انتخاب کنیم. استفاده کنیShift+F8 هم می توانیم از  
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Addnig حالت انتخاب کردن از استاندارد به حالت انتخاب اضMMافه)Shift+F8با    Selection)
تغییر خواهد کرد و فشردن مجدد آن انتخاب را به حالت استاندارد برمی گرداند.

انتخاب بلوک عمودی متن
از حالت انتخابی بلوکی رایتر می توانیم بلوکی از متن ها را از چند چند سطر انتخاب کنیم. بMMرای این

selectionوایریش < کار می توانیم از منوی   modeمارهMMشکل ش(د۸ یا نوار وضعیتMMا کلیMMی  )
  وshift، با کمک موشMMی یMMا 1۰ حالت بلوکی را انتخاب کنید و شبیه شکل ctrl+shift+f8ترکیبی 

دکمه های جهتی صفحه کلید بلوکی از  متن را انتخاب کنید.
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 متنسباندنبرش، رونوشت و چ
بریدن و رونوشت متن در رایتر شبیه برش و رونوشت متن در برنامه های دیگر است. مMMا می تMMوانیم
متن انتخاب شده ای را با کشیدن با موشی، کلیک راست، شمایل مربوطMMه یMMا کلیMMدهای میMMانبر  در
داخل سند یا بین اسناد رونوشت یا جابجا کنیم. همچنین می توانیم از دیگر منابع مثل صفحات وب

متنی را رونوشت بگیریم و آن را در سند رایتر بچسبانیم.

 جدید بکشید و رها کنید.محل موشی استفاده کنید و آن را به از )کشیدن و رها کردن(ابجایی متن انتخاب شدهبرای ج•

 نگهدارید.هم را در Ctrlبرای رونوشت متن انتخاب شده، ضمن کشیدن، کلید •

 را  برای بریدن متن استفاده می کنیمCtrl+X)بریدن و جایگذاری در محل جدید(، برای جابجایی متن انتخاب شده•
 متنچسssباندن بssرای Ctrl+Vو سپس مکان نما را در نقطه ای که قرار است جای گذاری کssنیم قssرار می دهیم  و از 

استفاده کنید. روش دیگر استفاده از دکمه های نوارابزار است.

( استفاده می کنیم قالب و سMMبک مبMMدا)مثلا نMMوع و انMMدازهpasteوقتی به طور معمول از چسباندن)
قلم( هم حفظ می شود.
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می دهیم( را بMهبرای اینکه متن جابجا شده، قالب بندی و سبک متن مقصد)جایی که در آن جMا قMMرار 
:خود بگیرد

 را انتخاب می کنیم یاPaste Specialاز ویرایش <  •

 نوار ابزار  کلیک می کنیم یا( Paste Iconچسباندن) مثلث کوچک کنارروی •

 تازیرمنوها دیده شود یا می داریمکلیک موشی را نگه  چسباندن، از نوار ابزار روی شمایل•

•Ctrl+Shift+V.را می زنیم  

.می کنیم( را از منو نتایج انتخاب Unformatted text )بدون قالب متن سپس

نکته

بچسبانیم.  Ctrl+Alt+Shift+Vمی توانیم متن را بدون قالب مبدا، در مقصد با زدن  

جستجو و جایگزینی متن

 برای اولین روش بMMرای جسMتجو اسMتفاده از نMوارابزار برای جستجوی متن در سند دو راه دارد:رایتر
 است. Find & Replace( است و روش دیگر استفاده از پنجره محاوره ای Find)جستجو

جستجو استفاده از نوارابزار 
پنجMMره برنامه مشاهده می شود، پایین 11به طور پیش فرض نوارابزار جستجو، همان طور که در شکل

 توضMMیح داده شMد امکMان1)درست بالای نوار وضعیت( مشMاهده می شMMود؛ همMانطور کMه در فصل
اگر این نوار ابزار را نمی بینید نگMMران نباشMMید می تMMوان آن را از. وجودداردجابجایی و شناور کردن آن 

 ظاهرکرد.Ctrl+F  یا (View > Toolbars > Findنما < نوارابزارها < جستجو )منوی 

راهنمای شروع به کار۷.1لیبره آفیس  | 34

: نوارابزار جستجوی پهلوگرفته در پایین پنجره۱۱شکل 



 بMMزنیم. ازEnter ورودی بنویسMMیم و کMMادر افیسMMت آن را در ، ک متن یا عبارت متنیبرای جستجو
 نیز می توانیم آن را اگر در موقعیتFind Previous یا Find Nextهای بالا و پایین  طریق دکمه

( نشان می دهد.Highlight هم همه یافته ها را برجسته)Find Allهای قبلی یا بعدی پیدا کنیم. 

خفی کردن این نوار ابزار  چندین راه دارد از جمله:م

 ابتدای نوار ابزارX دکمهکلیک روی •

 در زمانی که در کادر جستجو قرار داریمEscزدن •

 Find & Replaceاستفاده از پنجره محاوره ای  

( از روش های زیر اقدام می کنیم:12شکل   )Find & Replaceبرای نمایش کادر محاوره ای 

 Ctrl+Hکلیدهای میانبر •

.می کنیمرا از از نوارمنو انتخاب  Edit > Find & Replace ویرایش <...•

 روی نوارابزار جستجو Find & Replaceکلیک روی دکمه  •
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Otherهنگام باز بودن این کادر محاوره ای روی این اختیار را داریم که   OptionsاMMکلیک کنیم ی 
(را ببینید 12شکل ). امکانات جستجو را گسترش دهیم

برای استفاده از کارد محاوره ای جستجو و جایگزینی به ترتیب زیر عمل می کنیم:

 می نویسیمFindمتنی که می خواهیم جستجو کنیم را در کادر (1

 می نویسیمReplaceبرای جایگزینی آن متن با متنی دیگر، متن جدید را در کادر (2

)match case. مانند می کنیم گزینه های مختلفی را انتخاب ر صورت نیازد(3  بزرگی یssا کssوچکی حssروفتطابق با 
 کل کلمات یعنی متن مورد جستجو جزیی از یک کلمه نباشد مثلافقط )whole words onlyانگلیسی( یا  

اگر دنبال کلمه »دانش آمsوز«  هسsتیم دانش آمssوز در کلمssاتی ماننssد»دانش آمssوزان«، »دانش آموزهssا« یssافت نشssود(.
: جستجو فقssط در متن انتخssاب شssده، جسssتجو از مssوقعیت فعلیمثلهمچنین گزینه های دیگر هم  در دسترس است 

. سندمکان نما به عقب به سمت ابتدای 

یادداشت

در مثال جستجوی »دانش آموز« فقط در کلمات کامل، اگر »دانش آموزها« با فاصله
بین دانش آموز و ها به صورت »دانش آموز ها« نوشته شده باشد کلمMMه دانش آمMMوز

کلمه کامل و جدا از کلمه بعدی به نظر خواهد رسید و در نتایج خواهد آمد.

داده خواهدشssد و در نمssایش اگر نتیجه ای یافت شssود بssه صssورت برجسssته، می کنیم کلیک Find Next بر روی (4
 متن جدید جایگزین کنید.Replace با کلیک کردن بر روی صورت نیاز به جایگزینی

نکته

Replaceاز نیاز به مشاهده موردی نتایج نداریم با کلیک روی    AllاMMهمه نتایج ب 
متن موردنظرمان جایگزین خواهد شد.

هشدار

 باید با احتیاط و دقت و اطمینان استفاده کنیم چراکه اگر سند راReplace Allاز  
ذخیره  و بسته شود؛ دیگر قابل بازگشت به حالت قبل نخواهدبود.
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درج نویسه های ویژه

 ¢M¾ M© æ ç Ł ñ ö ø نویسه های ویژه مواردی است که در صفحه کلید پیدایشان نمی کنیم مثلا
. همگی نویسه های ویژه هستند

برای درج یک یا چند نویسه ویژه، نشانگر را در موقعیتی که می خواهیم نویسه ها ظاهر شMMوند قMMرار
می دهیم و به یکی از روش های زیر اقدام می کنیم:

Special نویسه ویژه)روی شمایل•  Character )تی ازssنیم تافهرسssک می کssتاندارد کلیssروی نوارابزار اس 
را13نویسه های برگزیده یا اخرا استفاده شده باز شود و برای درج، روی هر کدام که خواستیم کلیک می کنیم) شssکل 

 کssادرMore Characters(.همچنین می توانیم در انتهssای فهرسssت بازشssده،  بssا کلیssک روی دکمssه  ببینید
( را بازکنیم.14محاوره ای نویسه های ویژه)شکل

Insert درج < ... کلیssک روی منssوی•  > Special  Character  دنssاز  شssرای بssاوره ای بssادر محssک
( و سپس دوبار کلیک روی نویسه هایی ]از هر قلم یا ترکیبی از قلم هssا[ کssه  می خssواهیم درج14نویسه های ویژه)شکل

شود. نویسه هایی که انتخاب کردیم در سند درج می شود و همچنین به فهرست نویسه های اخیرا استفاده شssده اضssافه
می شوند.

 نویسه های ویژه مختلف هستند. اگر نویسه ویژه به خصوصی را پیدا نکردیمشاملقلم های مختلف 
را باید امتحان کنیم.لازم است قلم های دیگر 

3۷ | درج نویسه های ویژه

: درج نویسه ویژه از نوارابزار استاندارد۱۳شکل 



نکته

 برای مشاهده جزییات نویسه یک بار روی آن کلیک می کنیم تا جزییات آن از جمله
کدعددی آن مشاهده شود.

با دوبار کلیک روی نویسه مد نظر، نویسه مدنظر درج می شMMود و کMMادر محMMاوره ای
نویسه های ویژه همچنان باز می ماند. اما اگر روی نویسه مدنظر ]یMMک بMMار[ کلیMMک

 را بزنیم؛ نویسه درج و پنجره بسته می شود.Insertکنیم و سپس دکمه 
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راهنمای شروع به کار با لیبره آفیس-رایتر

۳فصل 
قالب بندی



مقدمه

وقتی یک متن ساده را در رایتر می نویسیم ممکن است از لحاظ ظاهری زیبMMا بMMه نظMMر نرسMMد و لازم
است به کمک قالب بندی، ظاهر متن را به گونه ای تغییر دهیم تا زییایی و خوانایی مورد نیاز را داشته

باشد. این فصل، اصول قالب بندی متن در رایتر را پوشش می دهد، مفاهیمی از قبیل:

قالب بندی بندها و نویسه ها•

قالب بندی دستی و سبک ها•

استفاده از قالب بندی خودکار•

ایجاد فهرست های گلوله ای، شماره دار یا طرحواره ای•

 توضMMیح داده شMMده اسMMت،2در این فصل فرض بر این است که با تکنیک هMMای متMMنی کMMه در فصل
آشنایی داریم.

قالب بندی نویسه ها

ما می توانیم بعد از انتخاب متن)نویسه های( مورد نظر، قالب های متعMMددی بMMه آن  اعمMMال کMMنیم.
مهم ترین ابزار های قالب بندی نویسه ها از طریق دکمه های نوارابزار قالب بندی  و با استفاده از پانMMل

نویسه ها در دسته خصوصیات نوار جانبی در دسترس هستند از جمله:

( و اندازه و جلوه های آنFont قلم)نوع•

(، زیرخط دار و…(Italic(، کج)Boldسبک نگارش قلم )توپر)•

رنگ قلم و پس زمینه آن•

نوع قلم، اندازه و جلوه ها
 را از راه های زیر می توانیم تغییر دهیم:نوع، اندازه، رنگ و جلوه ها و سایر ویژگی های قلم

 نوارابزار قالب بندیفهرست های کشویی قلم و اندازه و سایر دکمه های دراز  •

با استفاده از پانل نویسه ها در دسته خصوصیات نوار جانبی •

راهنمای شروع به کار۷.1لیبره آفیس  | 40



پنجره محاوره ای قلم•

 قلم غیر از کشوی فهرست اندازه قلم روی نMMوارابزار قالب بنMMدی، راه افزایش یا کاهش اندازهبرای
دکمه افMMزایش و کMMاهش انMMدازه قلم کلیMMکدیگری نیز وجود دارد؛ می توانید از پانل نویسه ها روی 

( تغییر می دهد.Point نقطه)2کنید که معمولا اندازه قلم را 

(Pointنقطه)

 اینچ1/۷2هر نقطه برابر است با 

تنظیمات روی محاوره  نویسه
( دارد.کMMه در این بخش نشMMان دادهtab( شMMش صMMفحک)زبانMMه یاcharacter نویسMMه)محMMاوره

می شود.برای باز کردن محاوره نویسه چندین راه وجود دارد:

 از روی نوار منو  Format > character قالب بندی < ... کلیک روی منوی•

character  از زیرمنوی characterکلیک راست روی متن انتخابی و انتخاب  ... •

 بازاست.Properties  نوار جانب، وقتی دسته Character پانل More Optionsکلیک روی چرخنده •

 و جلوه های قلمقلم، انداز، رنگ
ج(، عMMادی، تMMوپر، کشامل قلم، سبک)حالت های مختلف قلم نام( می توانیم 1۵)شکل قلم زبانهدر 

 آن را مشخص کنیم.اندازه و زبان

  موارد مربوطCTL Font موارد مربوط به زبان لاتین و از قسمت western Text Fontقسمت 
به زبان فارسی را تنظیم می کنیم.

( نیز می توانیم رنگ قلم و طیفی از جلوه ها را انتخاب کMMنیم کMMه البتMMه1۶)شکل جلوه های قلماز زبانه
برای مستندات رسمی چندان مناسب نیستند.
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موقعیت
در زبانه موقعیت می توانیم موقعیت نویسه ها را مشخص کنیم به این معنا که:1۷مطابق با شکل 
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 محاوره نویسهاز قلم زبانه: ۱۵شکل 

: زبانه جلوه های قلم از محاوره نویسه۱۶شکل 



 اندیس هستند چند درصد اندازه قلم اصلی باشند.گر و اپایین  یا اندیس بالا یا اندیس باشندعادی •

 درجه باشند یا به عبارت دیگر عمودی باشند یا افقی) 2۷0 یا 90، 0دارای زاویه •

دی
(عمو

فاصله بین نویسه های وجود داشته باشد•

(HyperLinkفراپیویند)
 کلیMMکبازبانه فراپیوند این امکان را با ما می دهد نشانی اینترنتی یا پرونده ای را مشخص کMMنیم تMMا 

آن پرونده یا صفحه اینترنتی باز شود.روی نویسه های انتخاب شده،  

(HighLight)سازیبرجسته 
زبان برجسته کردن می توانیم شبیه ماژیک های فسفری، نویسه های مدنظرمان را با رنگی دلخواه،از 

برجسته کنیم، همان طور که قبلا هم گفته شد، انجام این کار از نوارابزار قالب بندی و نوار جMMانبی هم
امکان پذیر است)دکمه کنار رنگ قلم(
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حاشیه ها
آخرین زبانه هم برای این که دور نویسه های خود به ترتیبی که مMMدنظر داریم، حاشMMیه ای بMMا جلMMوه

مدنظر خودمان اضافه کنیم. در مورد حاشیه ها در قسمت بندها توضیح بیشتر ارائه خواهد شد. 

قالب بندی بندها

برای قالب بندی بند نیاز به انتخاب بند نیست و تنها کافیست مکان نما در بند باشد. البته اگر چند
بند را بخواهیم همزمان قالب بندی کنیم باز هم لازم است ابتدا حداقل بخشMی از هMر دو را انتخMاب

 می توانیم قالب های مختلفی را به بندها اعمال کنیم، مثلا با استفاده از:کرده باشیم.ما

شمایل روی نوار ابزار قالب بندی•

  نوار جانبیProperties از دسته Paragraphپانل •

 منوی قالب بندی نوار منودردستورات موجود •

گزینه های موجود در محاوره بند•

 دربند از طریق دکمه های نوارابزار قالب بندی  و با استفاده از پانل بندمهم ترین ابزار های قالب بندی 
دسته خصوصیات نوار جانبی در دسترس هستند.

 دکمه ها و شمایل مربوط به بند معرفی شده اند.1۸در زیر شکل

بندی بندتراز
ترازبندی یا چینش که در اینجا منظور تراز بودن خطوط مد نظر است را با مثال توضیح خواهیم داد.

وقتی می گوییم این بند راست چنین است یا از راست تراز شده است منظور این است که فاصله همه
اولین کلمات آن بند از حاشیه سمت راست یکسان است.

که مشابه آن در نوار قالب بنMMدی وجMMود دارد بMMرای ترازبنMMدی1۸ شکل ۴ تا 1ما می توانیم از دکمه 
استفاده کنیم.شکل نمونه های از اعمال ترازبندی به متن را به شما نمایش می دهد.
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تورفتگی از چپ۱۵افزاش فاصله با بند بعدی و قبلی۸چپ چین)تراز چپ(۱

تورفتگی از راست۱۶کاهش فاصله با بند بعدی و قبلی۹وسط چین۲

تورفتگی اولین خط۱۷افزایش تورفتگی۱۰راست چین۳

فاصله خطوط۱۸کاهش تورفتگی۱۱تراز از دو طرف۴

گزینه های بیشتر از طریق باز شدن۱۲Hanging Indent۱۹گلوله ها۵
محاوره مربوطه فاصله قبل از بند۱۳شماره گذاری۶

فاصله بعد از بند۱۴رنگ پس زمینه۷

: پانل های سبک و بند از دسته خصوصیات روی نوار جانبی۱۸شکل 

متن راست چین یا از ترازشده از راست.
متن وسط چین

متن چپ چین یا ترازشده از چپ
(بین کلمات هر خط در صورتی که کل خط را پرنکنند، فاصله هایی درج می کند یاJustifiedمتن هم تراز شده)

در فارسی برخی کلمات کشیMMMده تر می کند تا فاصله ابتدای اولین کلمه از حاشMMیه راسMMت و آخMMرین کلمMMه از
حاشیه چپ، در خطوط ماقبل آخر یکسان باشد.

: گزینه های ترازبندی متن۱۹شکل 
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یادداشت

خط اول و آخر هر بند گاهی در ترازبندی استثنا می شMMوند. بMMه عبMMارتی گMMاهی بMMرای
زیبایی متن خط اول هر بند را تورفته می کنیم و خط آخر بMMرای این کMMه ممکن اسMMت

نیاز به فاصله و کشیدگی زیاد داشته باشد هم تراز با سایر خطوط نمی شود.

فاصله بین خطوط و بندهاتنظیم 
 مشMMاهده می شMMود، همMMان طMMور کMMه از نMMام آن1۸ شکل 1۸فاصله بین خطوط که در دکمه شماره 

پیداست فاصله بین خط زمینه دو خط است.

( است؛ بدیهی است با بیشتر کMMردن این مقMMدار،single)1به طور پیش فرض فاصله خطوط از هم 
فاصله خطوط از هم بیشتر و بالتبع تعداد خط در یک صفحه کم تر خواهد شد. مثلا اگر این فاصله را

.شده است)دوبرابر( قراردهیم انگار یک خط در میان نوشته 2

 دیده1۸فاصله بند اشاره دارد به فاصله عمودی بند با بند قبلی و بعدی، که همان طور که در شکل 
 قابل تنظیم است.البته اگر بخواهیم فاصله بند از بند قبلی متفاوت۹ و ۸می شود از طریق دکمه های 

 نشMMان1۴ و 1۳ با شماره 1۸از فاصله آن با بند بعدی باشد؛ مقدار مورد نظر را  قسمتی که در شکل 
داده شده، ثبت می کنیم.

تورفتگی
برای تورفتگی یا کنگره ای کردن متن در جهت زیبایی و خوانایی بیشتر متن، می توانیم از دکمه هMMایی

 بین حاشMMیه صMMفحه و خطMMوط بنMMد رافاصله خورده است، مقدار 11 و 1۰ برچسب 1۸که در شکل 
افزایش و در صورت نیاز دوباره کاهش دهیم.

 در همان شکل نیز می توانیم فاصله حاشیه از ابتدا یا1۶ و 1۵از تنظیمات مشخص شده با برچسب 
 هم مشخص کننده تنظیمات تورفتگی صرفا بMMرای1۷انتهای خطوط را نیز مشخص کنیم. برچسب 

اولین خط است.
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 را تغییر می دهد؛ بدین معنا که به جای تورفتگی خMMط اول، سMایرتو رفتگی خط اول کارایی 12دکمه  
خطوط غیر از خط اول شامل افزایش یا کاهش تورفتگی خواهندشد.

این بند نمونه ای است از تورفتگی خط اول بند است کMMه در بنMMدهای کتاب هMMا معمMMول
است. در بند بعدی نمونه ای از حالت برعکس آن خواهید دید.

hangingاین بند هم نمونه ای اسMMت از بنMMد بMMا تMMورفتگی همMMه خطMMوط غMMیر از خMMط اول)

indentتورفتگی غیر خط اول اغلب برای شماره گذاری بندها، یا قرار دادن شمایل یا .)
تصویری در ابتدای خط اول استفاده می شود تا شماره یا تصویر موجب تورفتگی ظMMاهری

خط اول نشود

رنگ پس زمینه بند
 نشMMان۷ چسب  با بر1۸شکل پس زمینه بند رنگی باشد می توانیم روی دکمه ای که در برای این که 

داده شده، کلیک می کنیم تا جعبه رنگ باز شود، یک رنگ انتخاب کنیم. اگر رنگ مورد نظرمMMان در
 رنگی سفارشی و دلخواه انتخاب می کنیم.رنگ هایی که اخیراCustom Colorجعبه رنگی نبود از  

 مشاهده می شود.Recentدر این قسمت یا سایر قسمت های برنامه استفاده شده است، در قسمت 
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نکته

, مانند این کتاب مورد استفاده قMMراررایانه ایفاصله گذاری بند اغلب در مستندسازی 
 معمولًا در سایر اسناد مورد استفاده قرار می گیرد. برای طراحیتورفتگی بندمی گیرد. 

 استفاده نکنید. از فاصله بند یا تو رفتگی استفاده کنید اما هرگز هر دو با هم،خوب

 بندتنظیمات روی محاورهٔ
  کMMه درصMMفحه پMMرش هMMاTabs بند شامل چندین زبانMMه اسMMت: پرش هMMا)

بزرگ نویسی اولین نویسه ها(،Borders Mتوضیح آن آمده است.(، حاشیه ها)
drop)یا کلمه ابتدای بند  caps(ناحیه ،) Areaرای پسMMگ بMMکه انتخاب های بیشتری غیر از رن 

زمینه بند فراهم می کند(، گلوله و شماره گذاری.

محاورهٔ
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تورفتگی ها و فاصله گذاری
انبیمشابه تنظیماتی که از نوار ابزار قالب بنMMدی و نوارجMM مشاهده می شود 21همان طور که در شکل 

در اختیار داشتیم در این محاوره نیز در اختیارمان است و البته این مزیت در این محاوره وجMMود دارد
که می توانیم قبل از اعمال، پیش نمایشی شماتیک را مشاهده کنیم.

(Alignmentترازبندی)
 ردیف کردن دیده می شود نیز تنظیماتی مشMاهده22در مورد ترازبندی متن که ترجمه آن در شکل 

می شود که در نوارابزار قالب بندی و نوارجانبی مشاهده کرده بودید.

این محاوره علاوه بر مزیت گفته شده در سربرگ قبلی)مشاهده پیش نمایش( ، این مزیت را دارد که
می توانیم برای خط آخر در تراز دو طرفه هم تعیین تکلیف کنیم. مثلا بخMMواهیم آخMMرین خMMط بنMMد،
وسMMMMط چین باشMMMMد یMMMMا آن هم ماننMMMMد این بنMMMMد، اجبMMMMاراً از دو طMMMMرف تMMMMراز باشMMMMد.
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Text Flow

؛ بMMهاز این زبانه مباحث پیشرفته تری در بر دارد که فعلا در این نگارش به توضیح آن نمی پMMردازیم
(؛ hyphenation)بط: خط رعنوان نمونه

گاهی نمی خواهیم متن ها برای ترازبندی کشیده شوند یا بین آن ها فاصله اضافی و می خواهیم انMMدازه
خMرین کلمMه خMط را دو قس- آhyphenationعادی خود را داشته باشند. در این حالت با خط ربط 

این کار را بیشتر در نگارش های دستی مشاهده کرده ام که می خواسMMتیم کلمMMه هMMای می کنیم.مت
بیشتری در یک صفحه جا شود و بندها دارای ترازبندی دو طرفه به نظر برسند.

(Outline & Numbering و شماره گذاری)طرح کلی
دکمهبرای این که بتوانیم رئوس یا خلاصه مطالب را فهرست یا شماره گذاری کنیم؛ غیر از استفاده از 

Outlineمربوطه روی نوار قالب بندی یMMا نوارجMMانبی اسMMتفاده از سMMربرگ   &  Numberingهم 
امکان پذیر است.

 ارائه خواهدشد.۵۴توضیحات بیشتر در مورد گلوله  ها و شماره گذاری در صفحه 

(Tabsپرش ها)
  به اندازه موردنیMMاز اسMMت، امMMا اینSpaceیک روش برای ایجاد فاصله خالی بین متون، زدن کلید 

روش، مناسب نیست و حتی ممکن است گاهی مشکل زا هم بشود؛ به همین دلیل درنرم افزارهای واژه
 :Tab کاربردهای برخی در نظر گرفته می شود. Tabپرداز برای کاربران، امکانی بنام 

کاربرد اول**************، مثلا شعر فارسیtabتعیین مقدار حرکت مکان نما پس از فشردن •

کاربرد دوم******************************************پر کردن فاصله با نویسه خاص •

کاربرد سوم*********************************************************ایجاد جدول•

 بعد از پرش، نوشMMتهleft  مشخص شده است؛ با انتخاب 2۳ داریم که در شکل Tab حالتچندین 
ها چپ چین نوشته می شوند) از چپ تراز می شوند(.

 هم می توانیم مسMتقیما وارد سMربرگبین حاشیه راست و چپ-با دوبار کلیک روی خط کش افقی -
Tabs.از محاوره بند شویم  
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 قراردهیم، نوع آن هم قبل از کلیMMک روی خMMط کش بMMاTabبا کلیک روی خط کش هم می توانیم، 
 قابل تعیین است.Tabکلیک روی علامت 

نکته

واحدهای اندازه گیری روی خط کش را می توانیم با کلیک راست روی آن بMMه واحMMد
مدنظر)سانتی متر، میلیمتر یا ….( تغییر دهیم.

نکته

استفاده از پرش ها برای صرفا ایجاد فاصله بین متون، چنMدان توصMیه نمی شMود.بMر
اساس کاربردی که مد نظر دارید استفاده از جدول و کادر انتخاب بهتری است.

51 | قالب بندی بندها

: تعیین ایستگاه های پرش از محاوره بند۲۳شکل 



(drop capsبزرگ نویسی اولین نویسه ها)
( از طریق اینdrop caps یا کلمه ابتدای بند )نویسه ها اولین 

مشابه همین بند()سربرگ امکان پذیر  است
بزرگ نویسی

 Whole  word انتخاب شود، اولین کلمه  به اندازه تعداد خطی در کادر LinesتهMMنوش 
شده است. بزرگ خواهد شد.

اگر
(Borders حاشیه ها)

موضMوع اصMلی متن، کMاربرد دارنMد؛ مثلا نکته هMا و یک یا چند بنMد از خارج کردنحاشیه ها برای 
یادداشت ها در همین کتاب با حاشیه پایین متمایز هستند.

 مشاهده می شود، ما می توانیم یک تMMا چهMMار طMMرف بنMMد،2۵همان طور که گفته شد و در شکل 
(.paddingحاشیه داشته باشیم،  حاشیه، می تواند از اطراف با متن فاصله داشته باشد)
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( هم داشته باشد. و در انتهMMا، گزینMMهShadow یک بند غیر از حاشیه، همچنین می تواند سایه)
Merge with next paragraphاین امکان را برای ما فراهم می سازد که بندهای انتخابی هر 

کدام حاشیه جداگانه داشته باشند یا همگی شبیه یک بند حاشیه داشته باشند.

(Areaسطح)
ناحیه یا سطحی که بند روی آن قرار دارد]که پس زمینه هم خوانده می شMMود[، نMMیز دارای تنظیمMMات

 قابل تعیین و تغییر است. Areaبیشتری است که از سربرگ 

 مشMMاهده2۶مزیت این سربرگ به نوارجانبی این است که غMMیر از رنMMگ، همMMان طور کMMه در شMMکل 
 حالت دیگر هم قابل انتخاب است.) طیف رنگ، تصویر، الگو و هاشور(۴می شود؛

به عنوان نمونه سطح یا پس زمینه همین بند، با الگو پر شده است.

53 | قالب بندی بندها

: گزینه های مربوط به حاشیه های بند۲۵شکل 



شفافیت
اگر پس زمینه ما تیره باشد و موجب ناخوانایی متن شود، جای نگرانی نیسMMت؛ این امکMMان در رایMMتر

وجود دارد که از طریق سربرگ بعدی آن را شفاف تر)شیشه ای( کنیم. 

لوله ها و شماره گذاریکار با گ

برای این که فهرست وار بیان کردن برخی مطالب لازم می شود از شMMماره گMMذاری بنMMدها یMMا گلولMMه
گذاری ابتدای آن استفاده کنیم. برای این منظور چندین راه وجود دارد:

استفاده از نوارابزار گلوله یا شماره گذاری •

استفاده دکمه های گلوله یا شماره گذاری از نوارابزار قالب بندی یا نوار جانبی•

 شماره گذاریواستفاده از محاوره گلوله •

Bullets and Numbringکلیک راست روی بند و انتخاب یکی از گزینه های منوی •
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برای تولید چنین فهرستی در ساده ترین حالت انتخاب بندهایی که می خواهیم شMMماره یMMا گلولMMه دار
شوند و سپس کلیک روی دکمه شماره یا دکمMMه گلولMMه از نMMوار ابMMزار یMMا پانMMل بنMMد در نMMوار جMMانبی،

امکان پذیر است.

نکته

بامMMا زیرفهرسMMتی  بنMMد دوم فهرست ما می تواند تودرتو باشد به این معنی کMMه مثلا
 نمونMMه ای از سMMطح بنMMدی2۷شماره یا گلوله گذاری جداگانه داشته باشد؛ در شکل 

 که می تواند برای ما فهرست تودرتو ایجاد کند را مشاهده می کنید.بندها

نکته

  شماره گذاری یMMاEnter البته اگر قبلا این دکمه ها را زده باشیم با رفتن به بند بعد با 
 ادامه می یابد.گلوله گذاری در همان سطح

استفاده از نوارابزار گلوله ها و شماره گذاری
)ایجMMاد زیرمجموعMMه یMMا سMMطح  و مMMدیریت فهرسMMت های تودرتوایجاداستفاده از این نوار ابزار برای 

(خیلی مفید است. مثلا اگر چند بنMMد کMMه شMMماره گMMذاریپایین تر برای یک عنوان و جابجا کردن آن
شده است را بخواهیم جابجا کنیم با نوارابزار به سادگی می توانیم بند ها را بالا)قبMMل از( بنMMد قبلی یMMا

  کنیم به ویژه اگرcopy & pasteپایین)بعد از( بند بعدی منتقل کنیم در حالی که اگر بخواهیم 

55 | کار با گلوله ها و شماره گذاری

)سطح اول شماره گذاری(فصل اول.1
مقدمه)سطح دوم شماره گذاری(◦
معرفی)سطح دوم شماره گذاری(◦

آشنایی با محیط)سطح سوم شماره گذاری(▪
فصل دوم.2

مقدمه.1
کار با متن.2

: نمونه از از فهرست تو در تو ۲۷شکل 



فهرست تودرتو باشد برای تنظیم مجدد شماره ها و ساختار مMMدنظرمان تلاش و زحمت فMMراوانی نیMMاز
خواهدشد.

نم.ا < ن.وار ابزاره.ا < گلوله ه.ا واگMر نMوارابزار را مشMاهده نمی کنیMد، بMرای ظMاهر کMردن آن، 
 را از نوارمنو دنبال کنید.(View > Toolbars > Bullets and Numbering)شماره گذاری

نکته

 فهرسMMتسطح صفحه کلید TABدر ابتدای هر بند با دکمه  افزایش تورفتگی یا دکمه
  سMMطح راShift+Tabکمه کاهش تMMورفتگی یMMا کلیMMد میMMانبررا کاهش می دهد و د

افMزایش می دهMد. در صMورت لMزوم بMه اسMتفاده از پMرش در بنMدهای شMماره یMا
 استفاده کنیم.Ctrl+Tabگلوله گذاری شده می توانیم از 

بندی یا نوار جانبیدکمه های گلوله یا شماره گذاری از نوارابزار قالب 
از جعبه شماره ها و گلوله ها می توانیم فهرست های معمMMولی ایجMMاد کMMنیم یMMا محMMاوره گلولMMه هMMا و

MoreشMماره گذاری را بMاز کMنیم.)...  Numbering... و More  BulletsانبیMه نوارجMالبت .)
 تغییر سطح یا جابجایی بندها که در نوار ابزار شماره گذاری دیده می شود  را ندارد.ابزارهای

: جعبه انتخاب نوع گلوله ها۲۸شکل  : جعبه انتخاب نوع شماره گذاری۲۹شکل    

گذاریعلامت  واستفاده از محاوره گلوله 
 از قبMMل تعریMMفرتیب دارد. چهار زبانه شامل سMMمبل ها و تMMزبانهمحاوره گلوله و شماره گذاری شش 

 اسMMتاندارد( وب طMMرح بMMا تMMرتی۸شده هستند:گلوله ها، شMMماره گذاری، طMMرح کلی)انتخMMاب از بین 
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تصویر)انتخاب تصویر علامت(. دو زبانه شMMامل جزییMMاتی اسMMت کMMه قMMالب تغیMMیر هسMMتند:زبانMMه
( که موقعیت علامت یا شماره ها و موقعیت)فاصله( و تورفتگی و پرش متن هMMرPositionموقعیت)

( کMMه در آن می تMMوانیم نMMوعCustumizeسطح)پله( از آن قابل تنظیم است( و زبانه شخصی سازی)
شماره گذاری که عددی یا حروفی باشد، از چه شماره ای شروع شود و غیره و حتی تصویری دلخواه

از رایانه خودمان به عنوان علامت ابتدای بند در سطح مورد نظر استفاده کنیم.

 می بینید از تصMMویر یMMاکریم بMMه جMMای۳۰همان طور که در ابتدای این بند و  درشکل 
علامت استفاده کرده ایم.

برای باز کردن محاوره علامت ها و شماره گذاری چندین راه وجود دارد:

( زیر جعبه شماره ها و علامت هاMore Bullets و ...More Numberingکلیک روی )...•

Bullets And Numbring از منوی ...گلوله ها و شماره گذاری…کلیک راست روی بند و انتخاب •

5۷ | کار با گلوله ها و شماره گذاری

: سربرگ شخصی سازی از محاوره گلوله ها و شماره گذاری۳۰شکل 



(Stylesقالب بندی: مستقیم)دستی( یا سبک ها)

دو گونه قالب بندی داریم که در ادامه توضیح داده خواهدشد.

 قالب بندی مستقیم]یا دستی[ 
اعمال قالب بنMMدی بMMه طMMور مسMMتتقیم روی بنMMدهای خMاص، نویسMMه ها، صMMفحات،قاب هMMا،
فهرست ها یا جداول. به عنوان مثال می توانیم کلمه ای را انتخاب کنیم و سپس روی دکمه ای

 کنیم.( کلیکItalic(یا کج)Bold)از نوار قالب بندی، مانند توپر

سبک ها
ه ای از گزینه هMای قالب بنMدی تحت عنMوان یMک نMام. بMه عنMوان مثMال، سMبک بنMد)بست

paragraph  styleله بینMMدازه آن، فاصMMد قلم، انMMمی تواند شامل تنظیمات معتددی مانن)
فاده کنیم با انتساب آن سبک بMMه بنMMدخطوط و غیره باشد که هرجای که خواستیم از آن است

خاص، همه تنظیمات یک جا اعمال می شود.

استفاده از سبک ها توصیه می شود
از آنجا که سبک ها مجموعه ای از قالب ها را، همزمان اعمال می کند،  به ما این توانایی را می دهد کMMه
قالب یک سند را منظم کنیم و با کم ترین زحمت، قالب بندی را در تمام سند اعمال کMMنیم. بنMMابراین
استفاده از سبک ها به شدت توصیه می شود. به علاوه این که استفاده از سبک ها قابلیت هایی ماننMMد

فراهم می کند که ممکن است از آن مطلع نباشید.ایجاد خودکار فهرست مطالب را 

 صفحه ای را با نرم افMMزار رایMMتر تMMایپ و صMMفحه آرایی2۰۰فرض کنید که می خواهیم یک کتاب مثلا 
کنیم؛ اگر به صورت معمولی از نرم افزار استفاده کنیم، بعد از تایپ کتاب اگر از ما خواسته شود قلم
یا رنگ بندی عناوین کتاب را تغییر دهیم، نیاز به صرف زمان زیادی دارد. یا اگر بخواهیم فهرسMMتی
از مطالب کتاب به همراه شماره صفحه آن استخراج کنیم، کار طاقت فرسایی است به ویMMژه اگMMر بMMا

تغییر اندازه قلم ها یا اندازه صفحه و...، شماره صفحات تغییر کند.
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( استفاده کرده باشیم همه این کار ها)به روزرسانی ها( با یک دستور بهStyleاما اگر از قابلیت سبک )
( یا  چند کلیک ساده انجام می شود.updateروز رسانی)

یادداشت

از ابتدای این فصل هر چه گفته بودیم، اعمال قالب بندی دستی بود امMMا سMMبک ها آن
[ بMMه آن۹ و ۸قدر کارا و کاربردی هسMMتند کMMه در نسMMخه اصMMلی کتMMاب دو فصMMل]

اختصاص داده شده است.

رایتر سبک هایی به طور پیش فرض دارد که قابل حذف نیستند و فقط می توانیم آن هMMا را مطMMابق بMMا
نظر خود تغییر دهیم؛ همچنین می توانیم سبک جدیدی ایجاد کنیم  و در نهMMایت بMMه جMMای این کMMه

 انجام دهیم سبکی را منتسب به بند، نویسه ها، صفحاتمان کنیم.هربار قالب بندی روی بندها

مدیریت یا در واقع اعمال یا تغییر سبک ها و ایجاد سبک جدید از چند روش امکان پذیر است:

more stylesاز کشوی فهرست سبک ها در ابتدای نوار ابزار قالب بندی و ...•

 طور آسان و سریع از دسته سبک ها در نوار جانبی به•

f11  از نوار منو یا syleمنوی •

 نما < نوار ابزارهاظاهر کردن نوارابزار سبک ها از•

page styleکلیک راست و انتخاب منوی بند یا نویسه یا ...•

اساس  بر  جدید  شمایل سبک  روی  کلیک  فعلی)ٔانتخاببا   New Style from Selectionیا  )
Editویرایش سبک)  Style یاری از۳1( محاوره ای مشابه شکلMخواهیم دید که در آن جزییات بس

( چه باشد؛ مشاهده می شود.Enterویژگی های قلم گرفته تا این که سبک بند بعدی)پس از 

یادداشت

در رایتر نویسه ها هم می توانند سبک داشته باشند؛ به عبارت دیگر می توانیم بMMرای
کلماتی که لازم است متفاوت از سایر کلمات بند باشد هم سبکی در نظر بگMMیریم تMMا

در صورت نیاز قالب)قلم، رنگ، اندازه و ...( همگی را یکجا تغییر دهیم.

59 | (Stylesقالب بندی: مستقیم)دستی( یا سبک ها)



احتیاط

 قالب بندی دستی ] که قالب بنMMدی مسMMتقیم هم خوانMMده می شMMود[، سMMبک ها را رد
ویت اعمال بالاتری دارد، به این معنا که اگر قسمتی را به طورمی کند یا به عبارتی اول

دستی قالب بندی کنیم، هیچ سبکی بر آن قسمت، اعمال نمی شود.

حذف قالب بندی دستی
برای حذف قالب بندی دستی، متن مورد نظر را انتخاب می کنیم و:

 را انتخاب می کنیم یاFormat > Clear Direct Formatting  قالب بندی < از نوار منو •

 را انتخاب می کنیم یاClear Direct Formattingروی آن کلیک راست می کنیم و  •

 روی نوار ابزار قالب بندی، کلیک می کنیم یاClear Direct Formatting شمایل  روییا •

•Ctrl+M.را از صفحه کلید می فشاریم 
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